Mountain Lion - What’s hot, what’s not

System Preferences
General 4 groups, subtle horizontal lines

Appearance now says ‘For Buttons, Menus, and Windows’ except Safari 6 partly ignores this.
(show window 3 buttons)

Highlight color - Safari does honor this one

Sidebar icon size - Affects Finder only, should be in Finder Preferences, right?

Show Scroll bars: Apple has killed the arrows at the ends of scroll bars altogether. You don’t even
see them unless you make them visible always. It seems Apple doesn’t want you to use a old
school mouse anymore. You have to use a pointing device with a scroll wheel, ring, ball or a
multi-touch top or a multi-touch trackpad. Just another sign they are merging the Mac with the
iPad. The iPad interface is winning.

Ask to keep changes when closing documents and Close windows when quitting an application.
Sort of related I guess. The later is part of the Resume function, which would reopen open
windows when you re-launch an application. It’s good they offer to shut it off, because many
people find that annoying. Still it’s not so bad an idea sometimes, so I'd suggest using the free
TinkerTool 4.9 where you can turn this Resume function on and off for specific applications.

The option to minimize a window by double-clicking it’s menubar, has been moved to the Dock
preferences panel. Doesn’t make too much sense, except it joins the option for minimize
windows into application icon and the minimization DOES go into the dock, so I guess so

Recent items, pop-up for how many to track now applies to all three categories at once. There used
to be separate pop-ups for each.

Desktop & Screen Saver - Major changes here

You always could have a different Desktop image per display, but you can have a different desktop
background image for each desktop space in Mission Control. I could never get that part to
work predictably. Never used Spaces virtual desktops anyway. I'm generally integrating, not
trying to keep things separate. | hide apps I'm not using at the moment and minimize windows
in apps | am using. Anyway, the scaling and tiling options are not visible for the standard hi-res
images, but the options exist for your photos. The Fit to Screen option particularly benefits
from the color picker for a background color if your photo is not the same aspect ratio as your
display. The Tile option only is visible for the lowest resolution pictures. Ideally I suggest you
create a properly dimensioned image in Photoshop or whatever program. There are a few new
Apple provided desktop pictures. There are a couple of new options for those who like to
automatically change their desktop background image, like “At login” and “Waking from sleep”
Changing the desktop every few minutes will slow down your computer, but the option for
“When logging in” isn’t so bad. It will probably occur just once a day.

The option for a translucent menu bar is still there, but I suggest turning it off so you can see your
menu items more clearly. I suppose if you have cleverly designed your desktop image to avoid
the menu items it would be OK, but they change with every program and some take up most of
the menu bar, right up to the menu extras bumping out of the right side.

Screen Saver: Major changes in appearance here. You now have a graphical picker for a slideshow
style screen saver and if you scroll down, the computed screen savers like the old standby
Flurry. The slideshows are like the iPhoto variety. If you have some old screen savers, many
will not work with Mountain Lion even if they did work with Lion. You have to check with the
software developer to see if there is an update. I tried the latest 3D Desktop aquarium v1.9
from Useless Creations, it seemed to work but then again it crashed System Preferences. There
is an option to add a modest size digital clock to your screen saver that moves. Compatibility
issue aside, it's a nice improvement. All that is just idle entertainment, it’s better to put the

1



display to sleep, rather than let a screen saver waste energy. The hot corners function works as
before. Good idea to use one at the bottom-left.

Dock: Just one new thing
The option to double-click a window’s title bar to minimize is here. Off by default, I think it’s a
good function to enable. ‘Minimize windows into application icon’, | prefer that off. On the
other hand, with this option on, one could argue that a bunch of minimized windows won’t
cause the existing icons to become really tiny. Folks with small displays probably will love it.
Animate opening applications, meaning bounce icon in the dock. I like that, particularly if
things go badly. The option to show indicator lights in the dock’s lowest edge for open
applications is a good thing, can’t think why anyone would shut it off. The indicator itself is
harder to see, just a bright little bar with a blue glow under the open applications.

Mission Control: Been there, done that with Exposé (in Snow Leopard)

In OS X 10.7 Lion, Mission Control replaced the Exposé and Spaces functions. F9 brings up
Mission Control, just like Exposé used to be. Option key brings up the plus sign tabs that offer
another desktop. Exposé was useful sometimes, so Mission Control has some value in my
opinion. While in a virtual desktop, you can right-click on an icon in your Dock and assign it to
always open in that desktop. That’s a good thing if you do use more than one desktop. Control-
left and right arrows switch between spaces and I prefer to turn off the first option in the
panel, Show Dashboard as a space. I think the multiple desktops for various apps makes more
sense that way. Nothing new here; really, just a refresher, F10 hides the other applications plus
your desktop icons.

Language and Text: Nothing new here worth noting, except I like to edit the list to just English.
No sense in having the computer worry about languages I'm not going to use. In the text tab, I
like to turn on the text substitution of the various fractions. If you are using a very small
typeface this won’t be good. I also tend to turn on the keyboard viewer in the Input Sources
tab.

Security & Privacy: Big changes here
General tab: First off, this a second place where you change your password, besides the Users
& Groups panel. If you are not an administrator, you can change your own password here. You
can now add a message while your screen is locked. Something like...

This is the computer of Bradley Dichter.

Anyone else who dares touch it

will be electrocuted, so I'd stay away.
You can also disable the automatic login here, besides the Users & Groups - Login Options
The more interesting and new function is in the lower half. This is the Gatekeeper control, even
though it’s not labeled as such. Gatekeeper is Apple’s sandboxing of applications to prevent
malware from getting away with controlling your computer. The default is the middle choice,
allowing you to run applications you’'ve downloaded from the walled garden of the Mac App
Store as well a identified developers with signed applications. Signed with a Developer ID for
their applications, installers and plugins. You will probably find Mountain Lion compatible
applications, but their installers are not signed, so you will have to change this setting to
Anywhere. And this applies to installing new programs. This does not apply to applications
already on your Mac’s hard drive. You could run any third-party application even if the setting
is “Mac App Store” which should be the most restrictive. Still, you should install what you have
to and set the Security setting back to protect yourself from malware, which would be from
unsigned developers, hopefully. That part is important; don’t leave the setting on “Anywhere.”
There is the Advanced... button, but nothing exciting and new there. This stuff used to be in the
General System Preference panel.
FileVault is the same as before. It will slow down your computer big time and make anything
unrecoverable if you have directory damage.
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The Firewall is basically he same as the Mac has had since OS X 10.5 Leopard, it’s application
based, rather than port based, which if course is user friendly.
The Privacy tab allows you to turn off Location Services for individual apps that may request
your location as determined without great precision by your WAN IP address. Generally that
would be Safari and Reminders and Twitter. If either program has requested your current
location in the past 24 hours, it will be noted here. You will also see Contacts listed. Programs
like iBooks Author, Carbon Copy Cloner, iDefrag, DEVONthink Pro Office, Google Chrome, Spell
Catcher, Skype and Thunderbird may want to access your contacts. Maybe only just the info in
you’re My Card to pull in default name and address or perhaps more. You can kill access to any
contact info for each listed application by unchecking the checkbox. If you have Twitter
enabled, (back in the Mail, Contacts & Calendars pane) any apps trying to access your Twitter
account will be shown here in a similar fashion. Finally you have the option to not send
diagnostic & usage data to Apple.

Spotlight: Not much new here
Search Results: Lion introduced Spreadsheets as a category and Mail Messages got renamed
Messages & Chats and Events & To Dos is renamed Events & Reminders. No doubt in
conjunction with the new Reminders application. There is a new Developer category for Xcode
files and HTML files. As before, uncheck what you don’t want Spotlight to find and rearrange
the sequence to make your most important type files show up at the top of the search results. If
you select By Kind from the Arrange pop-up in the Find window, it will group thusly. The other
tab, Privacy is the same as before, drag in any folder or volume you don’t want to get search
results from. Particularly useful if you have a backup clone of your hard drive, and it’s
annoying to get two copies of everything in your search results. Still, you can change the
keyboard shortcut here. Funny, good old command-F seems to be good to go still. A little
known shortcut in the Finder control-command-F invokes the Find window but defaults to find
by name instead of content. Far more useful more often than not. Also I tend to use the Privacy
tab to exclude my backup volume.

Notifications: All new, unless you have been using Growl
You can choose what categories and what order will show up in the Notification Center dark
linen bar on the right side of your screen. On my Mac, there is also Google Chrome, Opera,
Dropbox, DEVONthink Pro Office and Twitter. Curiously enough, Firefox 15 is not there. You
can click on an item, say a new email message and it will open in Mail. If you option click on the
notification icon in the menubar, it will disable the alerts and banners for the rest of the day.

CDs & DVDs: Nothing new here. One interesting note, the top two options, When you insert a
blank CD or a blank DVD are not present on Macs lacking a built-in optical drive, like a
MacBook Air or a modern Mac mini.

Displays: Very new here
The Display tab; usually would show a choice of resolutions. Lion had the highest resolution at
the top. Now you just have Best for (built-in) display radio button for this resolution and a
Scaled radio button which when chosen, shows the various compatible resolutions. No refresh
rate choices, which seems the new norm for LCD displays as opposed to the old-school CRT
displays. There is the usual brightness control and rotation control pop-up menu. If so
equipped, there will be a checkbox for the option to automatically adjust brightness for
ambient light. You can adjust the screen brightness with your keyboard as before, and this
slider will move left and right. F14 is down and F15 is up for full size keyboards, and compact
Wireless Keyboards use the F1 and F2 keys. This is assuming the checkbox under the Options
tab- Disable brightness buttons is not checked. You might think this only applied to the
brightness buttons actually on Apple’s Cinema displays, but it’s clearly also the keyboard
shortcuts. The Gather Windows button becomes a Detect Displays button if you hold down the
option key. There is no longer a way to show recent resolutions in the menu bar. You can check
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the box to show mirroring options in the menu bar, that’s all. The Arrangement tab, if you have
more than one monitor connected is no different. The Color tab is also the same as before, as is
the Display Calibrator Assistant. The Options tab is present if you have an Apple display
connected, where you can control the function of its power button on the right side. There are
three radio buttons. The usual is to turn the display on and off. You can also choose to have a
button press instead put the computer to sleep or wake it up. You can also disable it altogether.
As mentioned before, there is a checkbox to disable the brightness buttons. I'd say that it’s
best disabled to prevent accidental brightness changes when you are trying to turn the
monitor on or off. This Options tab has a lock icon you must click to make any changes here.

Energy Saver: Nothing new here, since Lion. A single pane on desktops and two tabs for AC
power and battery power on portables. On the other hand, Mountain Lion no longer has the
option for “Restart automatically if the computer freezes” as that seemed to cause too much
trouble. On portables, there is another option missing, the one for “Start up automatically after
a power failure” which seems reasonable, assuming you never have a dead battery.

Keyboard: A couple of updates here:

You can now turn off Key Repeat altogether. [ prefer it at the fastest setting. On portables, the
wording for ‘Adjust keyboard brightness’ now mentions ‘in low light’ which is how it’s always
worked, with an ambient light sensor. There is also a slider, which seems more appropriate for
the Energy Saver preference panel, it will turn off the keyboard backlighting after your set
amount of inactivity. The same old checkbox for showing the input menu and the Keyboard
and Character Viewer items thereunder is here. For users with a Windows targeted keyboard,
there is the Modifier Keys... button where you can reassign the option and command keys
which tend to be in the opposite positions, with the Windows key taking the place of the
command key. You can also reassign the caps lock and control keys, perhaps with no action if
you press them. Who wants to kill their caps lock key? I like to assign keyboard shortcuts here.
Like control-n for showing the notification center.

Mouse: As before, you'll see a varied appearance depending on Mac model and available pointing
devices with one new bit. There will be a checkbox for Scroll directions: Natural, which
reverses the time honored direction of the scrolling device so it’s more like the iPad. If you
have a laptop, which lacks a mouse, then you may see a image of a Apple Magic Mouse and the
computer is basically waiting for a discoverable Bluetooth mouse.

Trackpad: Visible even if you don’t have a trackpad. Basically the same as the revised version that
came with Lion with all the gestures. Apple has been pushing multi-touch gestures, and offers
the Magic Trackpad for use with desktop Macs. Only thing new is under More Gestures,
Notification Center, a two-finger swipe left. Makes sense as the Notification Center is hiding on
the right edge.

Print & Scan: Essentially unchanged since OS X 10.7 Lion. Used to be called Print & Fax under
Snow Leopard and older. It now will auto-detect (powered on) USB printers or Bonjour savvy
network printers and offer to download the driver software from Apple and create a print
queue. Pretty slick when you see it in action, it figures you have such and such Epson, Canon,
HP, etc. brand printer and it installs the brand printer driver bundle. If you have a network
printer without Bonjour, you’ll need it’s IP address. I use the inexpensive shareware IP Scanner
from 10base-t Interactive but LanScan from the App Store is free. Apple’s brand centric printer
driver bundles are the same for Snow Leopard through Mountain Lion, so no more and no less
support there. Still, you should check with the printer manufacturer’s web site for a better
driver and utilities. Despite the name, Print & Scan, if you have a HP all-in-one that supports
faxing as well, you should see a second print queue for the fax part. If you do, there will be a
checkbox to show the fax status in the menu bar and another for sharing the fax on the
network. Some fax machines can send the received faxes to the Mac. Supported and turned on
scanners would be listed below. “Why?” you may be thinking. Because they can be shared on
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the network like printers can. The method of resetting the printing system has changed from
before, and that was pretty hidden little trick too. You hold down the option key while pressing
the minus icon which represents remove the selected printer. If you happen to have no print
queues, then you can option-click on the plus sign.

Sound: Nothing new here. A little tangled tidbit | found about the Sound - Input tab. If you have a
MacBook or MacBook Pro, but not an iMac, there is a checkbox for “Use ambient noise
reduction” It's a curious thing, having two internal microphones. Some models have it and
some don’t and it's not well documented. The current MacBook Pro with Retina display has
two but the regular MBP has one. The 13” model lacks an audio in jack, but a USB microphone
would work. The 15” has a hybrid analog and optical digital audio input jack. The 15” MBP with
Retina has no external audio input.

iCloud: Nothing new from OS X 10.7.4. There was no iCloud in Mac OS X 10.6 and even the first
10.7.0 had no iCloud as it came out at the same time as i0OS 5 and OS X 10.7.2. You log in with
your Apple ID and set what apps and functions you want to sync to the iCloud. Once you have
synced information, that information is going to take up space. If you start saving files into the
iClould space, that will take up space too. You can click on the Manage... button, see where your
cloud space is going and then click the Change Storage Plan... button to pay for more space.
You are allowed 5GB of data for free. It's $20 for each additional 10 GB of space each year.
Purchased music, TV shows, apps, and books, as well as photos in your Photo Stream don't
count against your 5GB of free storage.

Mail, Contacts & Calendars: This was new for Lion and not much changed for Mountain Lion. It
does make things easier, setting up more than one linked service at a time that otherwise you
have to setup in separate applications. If you are upgrading from Snow Leo or Lion, then some
information will already be filled in. Clicking on an existing account will show info and options
relating to that account. The iCloud entry will remind you about your iCloud storage usage. It’s
interesting that Apple now supports Yahoo, Twitter and vimeo, and flickr. You may not have
heard of vimeo, it’s a video sharing web site, rather like flickr is primarily (or traditionally, as
they offer videos too now) for photos. 300 MB free. There is another account category for
adding an account for Messages, the new replacement for iChat. Other also includes a generic
CalDAV account on some server either on your network or elsewhere in the Internet for
appointments. You can add a generic CardDAV or LDAP account for shared contacts in an
office. Finally you can add an account on an OS X Server (10.7 or newer), which could offer
these services and more.

Network: Nothing new. A related tip that 'm not sure everyone knows. If you create a new
location here, you get a new Location item under the Apple menu, with your locations
hierarchical choices. For portable users, this shortcut should make life easier if one just notices
it.

Bluetooth: Basically the same as that from Lion. For those with wireless keyboard and/or mice,
the Advanced... button is the way to check that the “Allow Bluetooth devices to wake this
computer” is checked

Sharing: A few changes here
Apple took out the XGrid Sharing and Web Sharing options. Folks who used the built-in Apache
Web server which is still there, should look into using VirtualHostX and Click On Ideas’ Web
Sharing prefPane. Linked to the firewall in the Security preference panel. Scanner sharing will
be new to Snow Leopard users.

Users & Groups: Used to be called Accounts. Nothing new that’s worth mentioning here.

Parental Controls: Used with Users & Groups to limit what non-admin users have access to.
Despite the name, it could be used for low authorized adult users, not just children. Simple
Finder will basically keep you from the Desktop and bring back the Launcher from OS 9.
Probably a good idea for some users.
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Date & Time: Too bad it’s not linked to the Location from the Network Pref panel. Otherwise,
nothing new from Lion. The option under the Time Zone tab for setting the time zone
automatically based on my current location as culled from geonames.org and your network
connection.

Software Update: Simplified and now relies on the App Store. At least that makes sense,
combining updates for Apple software with third party software, at least those you
downloaded from the App Store. Of course that means you have to have an Apple ID to use the
store. Still it will show that there are updates available and you can click Show Updates button
to launch App Store to see them and update all or some. No way to check what Software
Updates you have installed in the past like you used to. Also no way to ignore an update. You
used to be able to change the frequency that it checks for updates. Now it only checks once a
week.. You can use a Terminal command to change that to daily: sudo defaults write
/Library/Preferences/com.apple.SoftwareUpdate ScheduleFrequency 1
You probably don’t want to check the options for ‘Download newly available updates in the
background’ and ‘Install system data files and security updates’. The download is invisible and
you only get a notification that it is ready to be installed. You lose control. Maybe you read that
some update will break a valuable add-on and you don’t want some update. The last option
(for Admin users only) is an interesting one. Automatically download apps purchased on other
Macs, linked to your Apple ID. If your spouse gets a new app on your shared Apple ID and
credit card, you probably want it too. At least you can keep track of what they are buying.
Considering that new App Store purchases show up at the end of your Dock, if a new icon
appears out of the blue, you know you just paid for it.

Dictation & Speech: Dictation is a standout new feature. Text to Speech: not all that new.
Speakable Items, the voice control function, is still available under the Accessibility pane. I
never got it to work too reliably. Dragon Dictate 3 works with Mountain Lion and it lets you do
editing and control by voice. It's off by default and requires an Internet connection. You can
control the audio input source on the left, if you notice the small down pointing triangle. You
may want to change the shortcut to some other function key via the Customize menu option if
you have a full size keyboard. The shortcut is good only for invoking the little recording
window. You'll see an animated microphone with the sound level shown. You probably will
have to go to the Sound preference panel - Input tab to change the input volume or ‘gain’. You
have to click the ‘Done’ button to send the snippet of recorded voice to Apple for transcription.

Time Machine: Looks similar but there are a couple important differences. You can select another
disk and you will get a new dialog box that reads “Do you want to replace the backup disk
“XXX” or back up to both disks? If you use both, Time Machine will take turns backing up to
“XXX” and “YYY”. You have a choice of buttons; Cancel, Replace “XXX” or “Use Both” You can
then spread out the wear on two hard drives, for an even safer backup plan. One nice touch is it
now shows you right away how much space is left on your backup drive and when is your
oldest and newest backup is and when you can expect the next backup. If Time Machine is
currently backing up, then you would see a progress bar. One other thing that may be new for
some users is the option to encrypt your backup. This is limited to Time Capsules or directly
connected drives with a GPT partition scheme, which is the norm for drives connected to Intel
based Macs. | would expect only users with FileVault protecting their internal drive would
want to also protect their backup drive. The other thing different is Time Machine preferences
under Lion would allow you to lock documents under the Options sub-panel. It’s funny that
you still have to go elsewhere to tell Time Machine to backup now. Either the contextual menu
for the Time Machine app’s icon or from the menu extra.

Accessibility: This was formerly called Universal Access. It got a major overhaul. [ rather like the
new Picture-in-picture Zoom style. There is now an input level Calibrate procedure to go with
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Speakable items and it can repeat back your Speakable items command instead of just making
a little sound. Still [ never quite got it to work reliably.

Startup Disk: Nothing new here.

System Preferences’ View menu - Customize... Uncheck to hide anything you don’t need on a
regular basis. Then click Done in the toolbar. Probably will freak out anyone else looking over
your shoulder, as most folks never change this, but I can see doing this for some of my clients
to help them focus on the important stuff. Show All button will not show the hidden ones.

Other: You probably have other 3 party System Preference panels. Most popular would be
Adobe Flash Player, but [ have 9 more under Mountain Lion and lots more under Snow
Leopard.

Finder and General GUI: Several things new here, particularly from Snow Leopard.

Menu bar is about the same, except the notification menu at the extreme right.

Dock indicators for in-use applications is different, separator is simpler and has similar function. Right-
click has a couple useful items in contextual menu.

No grow box in the lower right corner of windows. You can now resize a window by any edge to resize it.
Watch the cursor change, including at the corner and the top edge. This useful new interface came
with Lion. In fact, if you are careful, you can move a window by an edge, not just by its title bar, but
it’s a little tricky. Say you move your cursor to the left edge of a window, and your cursor becomes a
double-headed arrow left to right. If you pause and then drag perpendicularly to the cursor, up or
down in this case, then you move the window rather than resize.

Some programs, like Mail and Safari have a pair of diagonal arrows in the top-right corner. This is the way
to enter full-screen mode. For the record, I don’t like this. I want to do more than one thing at a time,
not hide everything else. What am |, a 4 year old or a 90 year old who will get confused? Anyway,
even the menu bar is hidden by your supersize window until you move your cursor up there. You
may notice in Safari that even the toolbar and button bar get hidden too. At least if you have two or
more tabs open, they are retained. Luckily a quick tap of your esc key gets you out of that. If you

forgot about your escape key, then maybe you will notice the blue icon = ﬂ at the
extreme right, even past the notification menu, if you move your cursor to the top of the screen in an
attempt to get back to normal. Clicking on that will also exit the full-screen mode. Another note of
how bad this feature is, if you have two displays, the other one is blanked with the gray linen design,
so they really want you to concentrate on one application window. The only person who probably
likes this function has a 11-inch MacBook Air with its 1366 x 768 resolution screen and you need to
make use of every pixel. There is a bit of cheat for full screen mode, if you need to see the menu bar
briefly. The command-space shortcut for Spotlight will bring that up and the menu bar. At least you
can check the time or WiFi signal strength.

The Finder windows used to have a lozenge looking button on the right of the title bar that would hide
the sidebar and toolbar which had the convenient effect, besides saving screen real estate, of forcing
the opening of another window with the contents of a double-clicked folder. This would make
moving files and folders around easy. Now you have to use the View menu and select Show/Hide
Toolbar or use the keyboard shortcut command-option-t. Curious but the menu item or the keyboard
shortcut not only toggles the toolbar, but it also toggles the sidebar, so it’s not named correctly. You
can’t show the sidebar in a window without a toolbar.

New Share button in toolbar is handy. Choice of Email, Message or AirDrop, if both machines are capable.
Message could be of the iChat to a computer nature or as a MMS to a cellphone.

Arrange button is new from Lion, lets you group your files instead of a basic alphabetical or chronological
list. Backing up old files, now separated by date ranges, makes things a tad easier. Maybe grouped by
size could be helpful in finding files or in conjunction with calculate folder size, where you are
wasting space.




The sidebar icons are no longer in color. There used to be a disclosure triangle to hide a group of icons in
the sidebar, say the FAVORITES. Now if you hover your cursor just to the right of the group name, a
button appears, like Hide and goes away when you move your cursor away. You have to remember
this if you want to reveal the group contents again, because if you hover in the right spot again, you
get Show. You can drag to rearrange the groups (new in Mountain Lion) and within a group, you can
drag to rearrange the entries. I'd put the important ones closer to the top, because if you resize the
window too short, you won’t be able to see the lower entries without scrolling the sidebar contents.
One of the new items you'll find in Lion and Mountain Lion’s sidebar, under the favorites group, is All
My Files. Normally viewed by type. Now I could see how this might be useful for first time users, but I
have well over three thousand files it considers to be human-useful files. The selection includes files
in my home folder and iCloud. It ignores files elsewhere, like other directly connected hard drives.
Personally | would suggest removing it from your sidebar as a distraction to getting serious work
done. You used to be able to drag a file to the sidebar favorites but you can’t anymore. You can drag a
folder there. Another thing missing is the group of saved searches; that got excised with Lion. You
can resize the sidebar by dragging the dividing line left or right. If you drag it all the way to the left, it
will snap close, hiding the sidebar, which can only be restored from the View menu Show Sidebar or
it’s keyboard shortcut command-option-s.

The scrolling direction is reversed by default from the way it used to be, to match the iPad. You can’t drag
it out again. To avoid accidentally dragging out icons, you have to either command-drag them out or
right-click and select ‘Remove from Sidebar’ from the contextual menu.

You used to have to use the command key in conjunction with clicking on the title of a Finder window to
get its path. Now you can control-click or right click it, but it’s just easier to use the View menu Show
Path Bar. You do know about the proxy icon in the title bar, dragging it where you need it, like into a
open or save as dialog box to move the focus there.

The home folder’s Library folder became hidden by default in Lion and continues to be hidden in
Mountain Lion. You can still get to it in the Finder by holding down the option key and selecting it
from the Go menu. Apple doesn’t want you messing around in there, but you may need to copy in or
out some important stuff like your Contacts (formerly Address Book) file, your Safari bookmarks,
cookie file and your email.

Spotlight has a couple of new tricks. One [ found useful is it can search for files based on the website they
were downloaded from. If you are a fan of the menubar spotlight search, reached by clicking or
command-space, after you type in a search criteria, the top hit is highlighted. You can just press
return to open that file or application. You can press the escape to erase your search criteria and
again to exit out of Spotlight. You may help direct your search with a keyword, for example kind:font
Helvetica will limit your results to just font files and exclude any other kind of file that includes
Helvetica in their content. I tend to search and then QuickLook for files when I don’t recall the name.
Just thought I'd add something here, not related to Mountain Lion. SneakPeek Pro is a QuickLook
plug-in that adds the ability to quicklook inside .ai and .indd Illustrator and InDesign files and .eps
files and it’s only 20 bucks.

If you are downloading something from a web site, while it's downloading, the Finder will show it’s
modification date as Jan. 24, 1984, the Mac’s introduction date. Also there will be a progress bar in
the size column. There also will be a progress bar in the Downloads folder icon in the Dock. Safari 6
no longer has an independent Downloads window, which I don’t prefer, just a little icon in its toolbar.
That also shows a progress bar during a download. Click on it to reveal the download list. Click a
completed download’s magnifying glass to reveal that item in the Finder. Double-click on the name to
open that file.



